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Abstract 
This study examines the causal mechanism of the grass-planting effect—a form of user-

generated content prevalent on Chinese social media—and its influence on consumer satisfaction 
toward China-Chic fashion products. Based on the Stimulus–Organism–Response (S-O-R) model, 
the research investigates the mediating roles of perceived value, perceived quality, and brand 
image. A quantitative survey method was employed, collecting data from 500 respondents with 
prior experience engaging with grass planting content and purchasing China-Chic fashion. Structural 
Equation Modeling (SEM) using AMOS was conducted to test the hypothesized model. The model 

demonstrated acceptable fit indices (χ²/df = 2.14, CFI = 0.96, TLI = 0.95, RMSEA = 0.048, SRMR = 
0.041), explaining 45% of the variance in consumer satisfaction (R² = 0.45). Key findings revealed 
that the grass planting effect had significant positive indirect effects on satisfaction through all 

three mediators. The path coefficient from grass planting to perceived value was β = 0.65 (p < 

0.001), to perceived quality β = 0.58 (p < 0.001), and from brand image to satisfaction β = 0.72 

(p < 0.001). Interestingly, a negative direct effect of grass planting on satisfaction was observed (β 
= –0.49, p < 0.05), indicating potential oversaturation or consumer skepticism when content is 
perceived as inauthentic. This study contributes to the digital marketing literature by extending 
the S-O-R framework into the cultural fashion domain. It offers strategic implications for marketers, 
emphasizing the need to shift from superficial virality to authentic storytelling, brand consistency, 
and emotional resonance to foster sustainable consumer engagement. 
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Introduction  
Over the past ten years, the Guochao trend, or "Chinese national fashion trend," has 

emerged as a significant catalyst in China's consumption sector, particularly among Generation Z 
customers, who prioritize cultural identification and local pride over mere product usefulness 
(Wang Y., & Li, M. 2023). Products that effectively convey cultural values in a modern context are 
likely to achieve greater appeal, particularly when marketed via digital channels.  

In this context, the "grass-planting effect" of user-generated content (UGC) on social media 
platforms like Xiaohongshu or Douyin has emerged as a significant mechanism for enhancing 
consumer motivation and emotional fulfillment (Zhang, L., et.al. 2022). These systems not only 
convey information about products but also generate "pre-consumption satisfaction" via 
transmitting experiences, trust, and empathy from other customers (Chen W., & Kim, S, 2023).  
Research has examined the function of key opinion leaders (KOLs) and the impact of social media. 
Nevertheless, comprehensive research on the "grass-planting" contributions of non-KOLs in 
fostering customer happiness across different dimensions, including perceived value, perceived 
quality, and brand image, remains comparatively scarce (Kapitan, S., et.al., 2022).  

Furthermore, no model exists that thoroughly incorporates the impact of emotions and 
social media information into the satisfaction process with Guochao items. This research seeks to 
examine the mechanism of the grass-planting effect on Chinese consumers' satisfaction with 
Chinese fashion products, employing the S-O-R (Stimulus–Organism–Response) conceptual 
framework and structural equation modeling (SEM) to analyze the causal relationships among 
variables including functional value, hedonic value, product quality, brand image, and consumer 
satisfaction influenced by social media content. (Somthawinpongsai, C., et.al.,2024).  
 

Research objective 
 1. To study examines the causal mechanism of the grass-planting effect—a form of user-
generated content prevalent on Chinese social media—and its influence on consumer satisfaction 
toward China-Chic fashion products 
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Scop of research  
Scop of Contents 
The Impact Mechanism of App-Grass Planting Effect planting on consumer satisfaction of 

Chinese national fashion products. Scop of Contents have to "Grass Planting Effect" The S-O-R 
(Stimulus–Organism–Response  

Scop of population 
This population consisted of Chinese consumers with prior experience engaging with “grass 

planting” content on social media platforms such as Xiaohongshu and Douyin, and who had 
previously purchased China-Chic fashion items. A multistage sampling technique was employed, 
and the sample size was determined using the Krejcie R. V., & Morgan, D. W. (1970) table, resulting 
in a final sample of 500 respondents with a 5% margin of error. 

 

Literature Review and concepts 
The "Grass Planting Effect" has attracted significant interest in digital consumer behavior 

studies, especially in China, where customers are frequently swayed by content shared by peers 
on sites like Xiaohongshu and Douyin. This mechanism differs from conventional marketing by 
prioritizing storytelling, experience sharing, and emotional involvement above straight advertising 
(Zhang, L., et.al. 2022). It profoundly influences consumer demand and contentment in product 
categories characterized by a strong cultural image, such as Guochao fashion brands. 

The S-O-R (Stimulus–Organism–Response) framework proposed by Mehrabian A., & Russell, 
J. A. (1974) elucidates consumer reactions in the realm of digital media. It asserts that "stimuli," 
like user-generated content and product reviews, influence the "organism," or the internal 
evaluative processes of customers, such as perceptions of quality or value, ultimately resulting in 
a "response," such as satisfaction or purchasing decisions. Numerous investigations validate that 
this model can proficiently elucidate customer behavior in the social media age (Kapitan, S,,et.al, 
2022). 

A crucial element in examining consumer response behavior is "Perceived Value," which 
encompasses two primary dimensions: Functional Value, about the product's performance and 
usability, and Hedonic Value, associated with emotional satisfaction, enjoyment, and self-



วารสารสมาคมนักวิจัย ปีท่ี 30  ฉบับท่ี 3 กรกฎาคม - กันยายน 2568          Page | 248 

 

 Journal of the Association of Researchers Vol. 30 No.3 July - September 2025 

perception (Chen W., & Kim, S , 2023). Consumers frequently base their decisions on a synthesis 
of these two dimensions, particularly with products designed to convey cultural identity, such as 
Chinese national fashion. 

Brand image is a crucial element affecting consumer happiness, particularly when social 
media material reinforces it in two aspects: product image and corporate image. Both aspects 
influence trust, attachment, and brand loyalty (Wang Y., & Li, M. 2023). The association of brand 
image with local culture or national pride enhances consumers' emotional assessment. 

Ultimately, consumer happiness is regarded as a significant outcome of the behavioral 
model in this study. Satisfaction emerges from favorable judgments of quality, value, and brand 
image on social media, influenced by the grassroots effect, particularly when customers interact 
with content that resonates with their identity. This research is important for connecting emotional 
consumer behavior with digital marketing within the framework of modern Chinese society. 

Theoretical Framework 
This research applies the Stimulus–Organism–Response (S-O-R) framework developed by 

Mehrabian A., & Russell, J. A. (1974) to explain consumer behavior in the context of digital 
media, particularly within the rising trend of “Guochao” or China-Chic fashion, which has gained 
popularity among young Chinese consumers. The S-O-R model posits that environmental stimuli 
influence internal cognitive and emotional processing, which subsequently leads to behavioral 
responses. In this study, the model is used to explore how digital stimuli , particularly user-
generated content on social media, shape consumer perception and satisfaction. 

The “Grass Planting Effect” serves as the key stimulus in this framework. This concept 
refers to the phenomenon where consumers are inspired or persuaded to purchase products 
after viewing relatable and authentic content created by other users on social platforms such as 
Xiaohongshu or Douyin (Zhang, L., et.al. 2022). These forms of content, often in the form of 
reviews, lifestyle posts, or recommendations, are seen as more credible and emotionally 
engaging than direct advertisements, thus making a stronger  impact on consumer decision-
making. 

The internal organism, or the consumer's cognitive-affective process, consists of three 
core components: (1) Perceived Value, including both functional value and hedonic value, (2) 
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Perceived Quality—divided into product quality and service quality, and (3) Brand Image—
encompassing product image and corporate image. Each of these mediators plays a significant 
role in shaping consumer perception and emotional engagement with the product (Chen W., & 
Kim, S, 2023; Kapitan, S, et.al. 2022). 

The final behavioral response in this framework is Customer Satisfaction, which is 
influenced not only by the tangible attributes of the product but also by emotional experience, 
symbolic identity, and brand association perceived through digital interaction. In the context of 
Guochao fashion, satisfaction stems from both the product’s performance and its ability to 
reflect the consumer’s cultural pride and personal identity (Wang Y., & Li, M. 2023). 

In summary, this research framework connects user-generated digital content with the 
psychological mechanisms and satisfaction outcomes of consumers. It proposes a causal model 
that integrates external stimuli, internal perceptions, and behavioral responses. This model can 
inform digital marketing strategies, online content creation, and brand development in an era 
where symbolic and cultural consumption is increasingly central to consumer decision-making. 

 
Figure 1: Conceptual Framework of the Grass Planting Effect on Consumer Satisfaction Based on 

the S-O-R Model 
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Research Methodology 
This study adopted a quantitative research approach to examine the causal mechanism of 

the grass-planting effect (user-generated content-driven inspiration) on consumer satisfaction 
toward China-Chic fashion products. The research design was based on the Stimulus–Organism–
Response (S-O-R) model, with structural equation modeling (SEM) applied to test relationships 
among constructs, including perceived value, perceived quality, brand image, and consumer 
satisfaction. 

The target population consisted of Chinese consumers with prior experience engaging with 
“grass planting” content on social media platforms such as Xiaohongshu and Douyin, and who 
had previously purchased China-Chic fashion items. A multistage sampling technique was 
employed, and the sample size was determined using the Krejcie R. V., & Morgan, D. W. (1970) 
table, resulting in a final sample of 500 respondents with a 5% margin of error. 

The primary research instrument was a structured questionnaire using a 5-point Likert scale, 
measuring key variables: (1) the grass-planting effect as the independent variable, (2) perceived 
value, perceived quality, and brand image as mediators, and (3) consumer satisfaction as the 
dependent variable. The questionnaire was validated for content validity by three experts and 
tested for reliability with a Cronbach’s alpha above 0.70 for all constructs, confirming internal 
consistency (Nunnally, J. C., & Bernstein, I. H. (1994). 

Data collection was conducted through an online survey, ensuring that participant 
qualifications matched the inclusion criteria. The data were analyzed using SPSS and AMOS 
software to assess model fit indices and test the research hypotheses. Model fit criteria included 

χ²/df, CFI, TLI, RMSEA, and SRMR, consistent with recommendations by Hu L. T., & Bentler, P. M. 
(1999). 

The results of SEM were used to validate the S-O-R-based model and to confirm whether 
the grass-planting effect significantly influenced consumer satisfaction through the mediating 
roles of value perception, quality perception, and brand image. This methodology supports the 
study’s contribution to digital marketing strategies in culturally driven fashion industries. 
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Research Results 
The analysis of the structural equation model (SEM) revealed that the proposed 

conceptual framework aligns well with the empirical data. Key goodness -of-fit indices, including 

the chi-square/degrees of freedom (χ²/df), Comparative Fit Index (CFI), Tucker-Lewis Index (TLI), 
Root Mean Square Error of Approximation (RMSEA), and Standardized Root Mean Square Residual 
(SRMR), met the acceptable thresholds recommended by Hu L. T., & Bentler, P. M. (1999). These 
findings confirm the model's suitability for explaining the causal relationships between the 
variables. 

The results show that the grass planting effect , user-generated inspiration found on 
platforms like Xiaohongshu, has a significant positive influence on perceived value and perceived 
quality. Both perceived value and perceived quality were found to have a significant effect on 
brand image, which in turn significantly influences consumer satisfaction (p < 0.05). Importantly, 
the grass planting effect also has an indirect effect on satisfaction through these mediating 
variables, illustrating a multi-step influence pathway that aligns with the Stimulus–Organism–
Response (S-O-R) model. 

In terms of explanatory power, the model accounted for a high proportion of variance in 
the dependent variable, consumer satisfaction, with an R² value exceeding 0.60. This indicates a 
strong predictive capability of the model. Among all structural paths, the effect of brand image 
on consumer satisfaction demonstrated the highest coefficient, highlighting the essential role of 
branding in shaping consumer experience and loyalty in the context of culturally-driven fashion 
consumption. 

Further validation was performed through an alternative model analysis, confirming the 
stability of the original model as no competing models demonstrated significantly improved fit. 
This adds further confidence to the robustness and generalizability of the proposed framework. 
Overall, the findings provide empirical evidence that the grass planting effect plays a crucial role 
in influencing consumer satisfaction through the mediating effects of perceived value, quality, 
and brand image. These insights are highly applicable for marketers and fashion brands seeking 
to leverage user-generated content and cultural resonance to enhance consumer engagement 
in the digital age. 



วารสารสมาคมนักวิจัย ปีท่ี 30  ฉบับท่ี 3 กรกฎาคม - กันยายน 2568          Page | 252 

 

 Journal of the Association of Researchers Vol. 30 No.3 July - September 2025 

 The model showed that the grass planting effect significantly influences both perceived 

value (β = 0.65, p < 0.001) and perceived quality (β = 0.58, p < 0.001). These two factors, in 

turn, significantly affect brand image, which is a strong predictor of consumer satisfaction ( β = 
0.72, p < 0.001). All path coefficients are statistically significant, supporting the hypothesized 
relationships within the S-O-R framework. 
 

Tabel 1 Summary of SEM Results 

Path Relationship Standardized Coefficient (β) p-value 

Grass Planting Effect → Perceived Value 0.65 < 0.001 

Grass Planting Effect → Perceived Quality 0.58 < 0.001 

Perceived Value → Brand Image 0.55 < 0.001 

Perceived Quality → Brand Image 0.47 < 0.01 

Brand Image → Consumer Satisfaction 0.72 < 0.001 

 
Figure 1 Structural Model Showing the Effects of the Grass Planting Mechanism on Consumer 

Satisfaction via Perceived Constructs 
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Table 2 Summary of Structural Equation Modeling Results Including Factor Loadings, Path 
Coefficients, and Explained Variance 

Latent Variable 
Indicator / Path 
Relationship 

Standardized Coefficient (β / 
Loading) 

Interpretation 

GZ (exogenous) GZ1 → GZ 0.82 Strong indicator 

 GZ2 → GZ 0.82 Strong indicator 

 GZ3 → GZ 0.87 Very strong indicator 

 GZ4 → GZ 0.78 Acceptable indicator 

ZL (exogenous) ZL1 → ZL 0.85 Strong indicator 

 ZL2 → ZL 0.87 Very strong indicator 

 ZL3 → ZL 0.88 Very strong indicator 

 ZL4 → ZL 0.89 Very strong indicator 

XX (exogenous) XX1 → XX 0.77 Acceptable indicator 

 XX2 → XX 0.78 Acceptable indicator 

 XX3 → XX 0.84 Strong indicator 

 XX4 → XX 0.87 Very strong indicator 

Z (mediator) Z1 → Z 0.87 Very strong indicator 

 Z2 → Z 0.87 Very strong indicator 

 Z3 → Z 0.87 Very strong indicator 

 Z4 → Z 0.87 Very strong indicator 

MY (dependent) MY1 → MY 0.61 Moderate indicator 

 MY2 → MY 0.68 Moderate indicator 

 MY3 → MY 0.72 Strong indicator 

 MY4 → MY 0.80 Very strong indicator 

Structural Paths GZ → MY –0.49 
Negative moderate 
effect 

 ZL → MY 0.17 Positive low effect 

 XX → MY 0.18 Positive low effect 
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Latent Variable 
Indicator / Path 
Relationship 

Standardized Coefficient (β / 
Loading) 

Interpretation 

 Z → MY 0.80 Positive strong effect 

Explained 
Variance 

MY (R²) 0.45 
45% of variance 
explained 

 

Summarize Discussion and Suggestions 
 Summarize 

 The model demonstrated acceptable fit indices (χ²/df = 2.14, CFI = 0.96, TLI = 0.95, 
RMSEA = 0.048, SRMR = 0.041), explaining 45% of the variance in consumer satisfaction (R² = 
0.45). Key findings revealed that the grass planting effect had significant positive indirect effects 
on satisfaction through all three mediators. The path coefficient from grass planting to perceived 

value was β = 0.65 (p < 0.001), to perceived quality β = 0.58 (p < 0.001), and from brand image 

to satisfaction β = 0.72 (p < 0.001). Interestingly, a negative direct effect of grass planting on 

satisfaction was observed (β = –0.49, p < 0.05), indicating potential oversaturation or consumer 
skepticism when content is perceived as inauthentic. This study contributes to the digital 
marketing literature by extending the S-O-R framework into the cultural fashion domain. It offers 
strategic implications for marketers, emphasizing the need to shift from superficial virality to 
authentic storytelling, brand consistency, and emotional resonance to foster sustainable 
consumer engagement. 

Discussion 
The findings confirm that the grass-planting effect, a type of user-generated content 

marketing often found on platforms such as Xiaohongshu and Douyin, significantly influences 
consumer satisfaction toward China-Chic fashion products. This influence occurs indirectly through 
three key mediating variables: perceived value, perceived quality, and brand image. These findings 
support the theoretical structure of the Stimulus–Organism–Response (S-O-R) model, which 
explains that external stimuli (such as digital media exposure) lead to internal cognitive or 
emotional responses that ultimately affect behavioral outcomes (Mehrabian A., & Russell, J. A. 
1974). 
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Most notably, brand image emerged as the strongest predictor of consumer satisfaction 

(β = 0.72), suggesting that while social content can influence purchase intention, long-term 
satisfaction is grounded in how well consumers relate to the brand's cultural and aesthetic 
identity (Keller, K.L.2009). This is consistent with prior studies emphasizing the importance of 
symbolic and emotional value in digital brand-building, especially among Gen Z consumers 
(Schivinski B., & Dabrowski, D., 2016). 

Interestingly, the direct negative path from GZ to MY (β = –0.49) highlights a critical insight: 
overuse or inauthentic deployment of grass planting strategies may result in consumer fatigue or 
distrust. This echoes findings by De Veirman, M., Cauberghe, V., & Hudders, L. (2017), who note 
that excessive influencer marketing can reduce credibility and engagement when not perceived 
as authentic. 

Theoretically, the study extends the S-O-R model into the realm of cultural fashion 
marketing in digital ecosystems. It confirms that perceived value, quality, and image are crucial 
mediators of satisfaction in environments shaped by social influence and digital storytelling (Kim 
H., & Johnson, K. K. P., 2016). Practically, it provides marketers with a model to enhance not just 
visibility but meaningful perception through strategic cultural branding. 

In conclusion, while grass planting effects serve as an effective stimulus, sustainable 
consumer satisfaction depends on how well brands build emotional, symbolic, and cultural 
connections. Brands must go beyond virality to foster long-term value through authentic content, 
product excellence, and identity alignment. 
 

New Knowledge form Research  
This study generates new knowledge that enhances the understanding of consumer 

behavior in the digital era, particularly in the domain of cultural fashion (China -Chic). It extends 
the application of the Stimulus–Organism–Response (S-O-R) model to explain the role of the 
Grass-Planting Effect, defined as user-generated content (UGC) on social media platforms, which 
acts as a stimulus influencing consumers’ evaluative processes (organism)—including perceived 
value, perceived quality, and brand image—and ultimately leading to consumer satisfaction 
(response). The findings confirm that the Grass-Planting Effect exerts a positive influence on  
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satisfaction through these mediators, with brand image emerging as the strongest 
predictor. However, the research also uncovers a critical new insight: the Grass-Planting Effect 
may generate a direct negative impact on satisfaction when content is perceived as overly 
repetitive or lacking authenticity, resulting in oversaturation and consumer skepticism. This 
indicates that the power of UGC is not solely positive but also carries challenges in balancing 
virality with credibility. 

The new contribution of this research demonstrates that consumer satisfaction with 
cultural fashion products is shaped not only by utilitarian factors but also by symbolic value, 
cultural identity, and authenticity in digital storytelling . This work fills a theoretical gap in 
UGC and consumer behavior studies and provides practical implications for marketers. It suggests 
that sustainable consumer satisfaction depends on content strategies that create emotional 
resonance, reflect cultural values, and maintain brand consistency in digital ecosystems. 
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